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Copyright

Notice

©2003-2011 Premier Assistive Technology, Inc. All Rights Reserved. This
documentation and the accompanying software are copyrighted materials.
Making unauthorized copies of this material is prohibited by law. No part of the
software or documentation may be reproduced, transmitted, transcribed, stored in
a retrieval system or translated into any human or computer language without
prior written permission of Premier Assistive Technology, Inc. Premier Assistive
Technology, Inc. asserts its "Moral Right" to be identified as the author of this
work, in all jurisdictions which recognize the "Moral Right."

UNLESS OTHERWISE PROVIDED BY WRITTEN AGREEMENT WITH
PREMIER ASSISTIVE TECHNOLOGY, THIS PUBLICATION AND THE
SOFTWARE SOLD WITH THIS PUBLICATION ARE PROVIDED "AS IS"
WITHOUT WARRANTY OF ANY KIND EITHER EXPRESSED OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FIT THIS PARTICULAR
PURPOSE. THE ENTIRE RISK ARISING OUT OF THE USE OR
PERFORMANCE OF THIS PUBLICATION AND SOFTWARE REMAINS
WITH YOU. IN NO EVENT WILL PREMIER ASSISTIVE TECHNOLOGY
INC. OR ANY OF ITS SUPPLIERS, BE LIABLE FOR ANY LOST PROFITS,
LOST SAVINGS, DIRECT, INCIDENTAL OR INDIRECT DAMAGES OR
OTHER ECONOMIC OR CONSEQUENTIAL DAMAGES, EVEN IF
PREMIER ASSISTIVE TECHNOLOGY, INC. OR ITS SUPPLIERS, HAVE
BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. PREMIER
ASSISTIVE TECHNOLOGY, INC. RESERVES THE RIGHT TO MODIFY
THIS DOCUMENT AT ANY TIME WITHOUT OBLIGATION TO NOTIFY
ANYONE. IN NO EVENT SHALL PREMIER ASSISTIVE TECHNOLOGY,
INC. OR ITS SUPPLIERS' LIABILITY UNDER THIS AGREEMENT EXCEED
THE SUM OF ANY AMOUNTS PAID HEREUNDER BY THE CUSTOMER
TO PREMIER ASSISTIVE TECHNOLOGY, INC. OR THE SUPPLIER.

Trademarks

These other marks include, but are not necessarily limited to the following.
Premier Literacy is a registered trademark of Premier Assistive Technology, Inc.
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You shall not use any of the Trademarks or Service marks of Premier Assistive
Technology, Inc., or any other entity, without the express written permission of
such Trademark or Service mark owner.

Deletion or Modification

If any portion of this manual, including but not limited to the "Notice" section
above, is held to be unenforceable, then that portion shall be deleted, and the
remaining language shall be given its broadest legal effect.

Premier Assistive Canada
PO Box 875, STN A
Sydney, NS

BIP 6J4

Phone 902-482-4680

Fax 902-270-5224
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Who should use E-Text Reader MAC?

The E-Text Reader MAC is designed to help those who have trouble reading or
comprehending the printed word. There are thousands of literature titles now available in
electronic format. Electronic forms of information pose the same difficulties as hardcopy
for those with reading challenges. The E-Text Reader MAC solves this problem. This
reader uses digital voices to read the electronic version of books (E-Books or E-Text)
aloud. The E-Text Reader MAC can read any document in Standard Text or Rich Text
Format (RTF).

E-Text Reader MAC Features

Compatible with: Standard Text and RTF.

Cut and Paste “to” or “from” any program.

Highlights and tracks each word as it reads.

Change Text and Background colors.

Adjustable Reading Speeds.

Bookmarks. Insert bookmarks to mark locations in the text.

Highlighting Features. Use the built-in highlighters to highlight text for

studying and review.

8. Highlight Extraction. Use the extraction feature to extract only highlighted
information (even multiple colors).

9. Read only Highlighted Text. E-Text Reader MAC can be directed to read only
highlighted text.

10. Change Fonts. You can change the default Arial font to any font on your
computer.

11. Zoom. No more fine print. Magnify the document up to 4X or change the font

size.

NS AN

About E-Text Reader MAC

The E-Text Reader MAC is designed to be a reading tool. It can be used to open and
read existing documents on a computer or text can be cut and paste from any program on
a computer. It can also be used to insert pictures into the text. It is an “easy to use”
reader that gives the user the ability to change voices, read at any speed, and to make
notes in the document that is being read.

The interface of the E-Text Reader MAC is actually a word processor which allows the
user to select and highlight text in much the same way a highlighter would be used in a
traditional book. The user can also insert any number of bookmarks. These bookmarks
can be saved with the documents which allow the reader to quickly go to a specific
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section of the text. In addition to highlighting and bookmarks, the user can “underline”
and “bold” text for easy identification.

Everything in the E-Text Reader MAC can be controlled with hot keys or buttons on the

toolbar, making it easy to use. There is also a built-in electronic manual so that the
E-Text Reader MAC can read the manual aloud.
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The E-Text Reader MAC

The E-Text Reader MAC has three main sections: the menu, the toolbar and the reading
area. Every main function of the E-Text Reader MAC can be controlled from menus.
“Hot keys” and buttons have been added on the toolbar for the most common functions.
The E-Text Reader MAC can only have one document open at a time. The title of the
open document is always present in the title bar of the E-Text Reader MAC. If no
document is open, the title bar will only say “E-Text Reader”, and there will be no
document displayed.
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1 would like to intraduce you to Team Premier - Premier Literacy’s commitment to literacy, breaking
down barriers and learning how to soar.

| founded Premier Literacy to develop technology that will help people to reach their full potential. |
have spoken locally, nationally and internationally an “how not to limit yourself*. | have traveled acrass
Canada and the United States delivering the message “if you believe you can, maybe you can®. It was a
great line, but it eventually became just words. | was guilty of not following my own advice. | was guilty
of paying mere lip service to the core philosophy which had been such a driving force in my life. After
little soul-searching, | came to the conclusion that if | was going to continue to “talk the talk’, it was time

to “walk the talk" and Team Premier was born.f}

I was a bicyele racer before | lost my vision in my early twenties. Though | have never allowed my sight,
ar lack thereof, to get in my way, | thought | had to give up competition. How could a blind man
compete again? | turned my energies toward building a life | was comfortable with in spite of my visual
challenges. The years that followed were kind in that | discovered my passion for literacy and a
commitment to sharing it. In almost every way, my life was perfect. Life, however, always comes with a
“but”. Turning 41 last year, tipping the scales at nearly 300 pounds and being unable to walk up a flight
of stairs and keep my breath was the “but”. Years of being on the road with work and nat watching what
| put in my mouth had taken a heavy toll. It was a far cry from my racing days.

[

| decided that if | could “talk the talBk" about not limiting yourself and believing that you can do
anything, it was time for me to put my money where my mouth was. | decided that a life change was
necessary and that | would “talk the talk” and “walk the talk”. 1had a lot of undoing to do from years of
inactivity and nat watching what 1 put into my mauth, but | began training again

My goal was to get back in shape and run some 10€ races. 1 had hoped that | might even be able to do a

half macathon Afior locine o fiect E0 pounde Leboctod to malbynick uo conordsbich anablod me o

New Document
To create a new document, press 6 + N or go to the File menu and select New.

Selecting New will clear the screen of any text. Information on the screen must be saved
prior to selecting New.

Opening a Document

The E-Text Reader MAC can open Rich Text Formats and standard text files. To open a
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document, go to the File menu and select Open, click on the Open button , or
press 3£ + O. This will open the standard Open dialog box.

O™ Open
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[ My Music 10-06-19
PLACES About Stacks.pdf 10-06-05
SEARCH FOR « FileStorm Extras 09-12-29
(L) Today
(L) Yesterday
(L) Past Week
All Images
All Movies
(51 All Documen ts
[ Cancel ) Open

Select the desired file and click the Open button to open the document in the reading
window.

Saving a Document

There are two ways to save a document: (1) Save, &8 + S or (2) Save As, Shift + 3£ + S.
An existing document, can be saved using the Save feature. When saving an existing
document, the user will not be prompted for a file name. When saving documents that
have not given the document a name yet, E-Text Reader MAC will prompt the user for a
file name and file type in order save it.

It is important to note that saving a document as a standard ASCII file will result in all
formatting being lost. The bookmarks will remain, but the formatting will be removed.
Documents that have been highlighted or text within the documents has been changed
should be saved as a Rich Text Format in order to retain these changes.

Save

To save changes to a document, select the Save button from the toolbar . Ifno
message is displayed, the file was saved successfully. The user will only be prompted if

an error occurs when you are trying to save a document. A prompt will appear if an
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attempt is made to save a document that has not been named. See the Save As dialog
box in this section for more information. Documents can also be saved using the button
of a blue diskette below the menu bar to save changes to the document.

Save As

The Save As dialog box will appear in two different situations.

1.) When a document is saved for the first time, a file name, file type and file
location must be supplied. By default, when a new document is created, it is
given the name “untitled”, the file type is RTF, and the location is “Documents”.

2.) The Save As feature can also be used to copy files. The Save As feature can be
used to save a file under a new name. The original file is preserved and a copy is
made.

Close

There are safeguards built into the Close feature to prevent losing any changes made to
an existing document. The user will be prompted to save any changes made to a
document prior to closing it. The Save As dialog box will also appear to prompt the user
to name an un-named document prior to closing. See the Save As section of this manual
for more information about the Save As function.

Reading a Document

To read a document click the Read button . The reader begins where the cursor is
currently located and continues until it reaches the end of the document. To stop reading,
click the Stop button. Click the Read button to resume.

To read one line at a time, enable Line by Line reading from the Reading Options

window under the Read menu and then use the Up or Down arrow keys. The system will
read the line where the cursor moved.

Read Just the Highlights

The E-Text Reader MAC can read just the highlights in the document. It will read them
in the document where are located and they will not removed in order to be read. To read

just the highlights, select the Read HL icon @ from the toolbar.
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Stop Reading

To stop the system from reading, click the Stop button . Click the Read button to
continue reading.
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Settings Menu

The E-Text Reader MAC will automatically save any setting that is changed and will
always retain the most recent settings.

Default Fonts

The user can choose the default font style and font size. To set the default font and font
size go to the Setting menu and select “Default Fonts...”.

~ &

Options WVoices

0

Preferences

|_| Read Line By Line when using arrows Keys

Default Text Options

Size Font

12 o | Century Gothic = ]

K f

Cancel Ok

Colors
The E-Text Reader MAC comes with several different color settings:

White background with black text (This is the default.)
Black background with white text

Blue background with yellow text

Black background with green text

White background with red text.

To choose the desired color scheme, click on the Settings menu and then select Colors.
From the Colors submenu, select the desired color scheme. The active color scheme is
the one that is checked.
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Zoom

The E-Text Reader MAC includes a zoom feature. The zoom feature allows users to
zoom from 25% to 400% of the current font. The reader will work at any magnification
level. The default setting is 100%.

The quickest way to zoom in on a document is to click on the Zoom button on the

toolbar . Each time the Zoom button is clicked, text will enlarge until it gets to
the largest setting. Click the Zoom button until the desired size is reached.

An alternate method to change the zoom level is to click on the Settings menu and then
select Zoom. The Zoom submenu that appears lists all of the available zoom percentages.
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Edit Menu

The Edit menu is only available after an existing document has been opened or a new
document has been created. The Edit Menu contains options to manipulate text.

Highlight

The E-Text Reader MAC has a built-in highlighter. Select the desired text to highlight

and click the highlight button/ or press +H. The text that has been selected will
be highlighted. This is a useful study feature and there are multiple highlight colors
available.

Highlight Colors

The E-Text Reader MAC contains multiple highlight colors: yellow, green, pink and
blue.

The highlight color can be changed by clicking on the color button on the toolbar: €eler:,
Every time the highlight Color button is clicked, the color changes. The color displayed
is the color that will be used for the next highlight.

Extract

B D

The powerful feature of highlight extraction will search the contents of a
document and find all the highlighted information allowing the user to extract it into a
new document. All of the highlighted colors can be extracted or selected colors may be
extracted. This new document can be saved or read. For more information on highlight
extraction, see Extracting Highlights later in this manual.

Clear Highlight

To remove a highlight, select the entire highlight or the part of the highlighted text and
select the Clear Highlight from the edit menu or +L.
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Clear All Highlights

The Clear All Highlights feature allows the user to remove all highlights from a
document. Highlights to be removed are selected by color.

1 Clear Highlights X]
Clear Highlights

v “rellow

I Gieen
v Pink

f | K

DK Cancel

Place a check next to the colors to be removed. Colors not checked will remain in the
document.

Cut( +X)

The Cut feature removes the selected text from the document and places it on the
clipboard. The clipboard holds this information until the next cut command is activated.
If Cut is selected twice, only the last information will be retained on the clipboard.

Copy( +C)
The Copy feature is very similar to the Cut feature, except that it does not remove the
selected text from the document. Instead it makes a copy of it and places it on the

clipboard.

Paste( +V)

The Paste feature pastes whatever is on the clipboard into the document. The information
that is pasted from the clipboard is placed where the cursor is located in the document.
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Undo( +2)

The undo command can undo your last functions. Just click the Undo icon or
select undo from the edit menu.

Select All( +A)

Select All highlights the entire document.
Find( +F)

The user can search for a word or part of a word using the Find option. To open the Find
dialog box, click on the Find button from the Edit menu. In the “Find what” edit box,
type the word or partial word to be located.

By default, the Find feature will start searching from the current location in the document
to the end of the document. Users can select the Up radio button to search from the
current location up to the beginning of the document, or select the Down radio button to
search from the current location down to the end of the document. Click Find Next to
find the first occurrence of the word, and then continue clicking on Find Next until all
occurrences of that word have been found.

- — " " -
L Find Previous )L Find Next

T
[ Close
M
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Spell Check
The E-Text Reader MAC comes with an integrated talking Spell Checker. The spell
checker is accessed by selecting Spell Check from the Edit menu. Words that are

misspelled will be underlined red.

Right clicking on a word that is misspelled will cause a context menu to pop up with
suggestions for replacing the word.
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Bookmarks

The E-Text Reader MAC has a bookmark feature. This bookmark feature allows the user
to insert as many bookmarks into a document as desired. These bookmarks are useful for
marking points of interest within a document. Bookmarks can also be used to mark the
last text read to allow the user to return quickly to that exact location within a document.

Insert Bookmark

To insert a bookmark, place the cursor at the point in the text where the bookmark is to

be placed and click the Mark button@. This will insert a bookmark where the cursor
is currently located.

Move to Prior Bookmark

The E-Text Reader MAC lets the user traverse through the bookmarks quickly by

clicking on the Prior button on the toolbar. The Prior button moves the user
from the current location the bookmark immediately prior to the current location.

Move to Next Bookmark

To go to the next bookmark, click the Next button E on the toolbar.
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Auditory Highlighting

Auditory highlighting is a technology designed to help individual comprehend better and
retain more of what is being read when using Text to Speech.

When the document is read aloud, two different voices are used. One voice is used for
the bulk of the document and a second voice is used for the more important part. The
first voice or primary voice will read the bulk or content of the document. When the
voice arrives to part of the document that is highlighted, the voice will change. The
secondary voice remains engaged for the duration of the highlighted text being read and
then the voice will revert to main voice used for the bulk of the document. The change of
the voices provides auditory clues, in addition to the visual clues that help readers to
remember that information is brought to the reader’s attention

Auditory Highlighting options are found on the voice window. To activate auditory

highlighting, click the voice icon . This opens the voices window displaying the
auditory highlighting and voice options.
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Voices

The top part of the window displays the primary or normal voice choice. This is the
voice that reads the body of the text when the advanced reading options are selected or
the entire document when the advanced reading option is not enabled.

Readers can scroll through the list of voices to find the desired voice. Once the desired
voice has been selected, the rate can be adjusted by moving the Voice Rate slide bar to
the right for faster and left for slower. Select the Test button to hear what the new settings
sound like. The Rate can be adjusted from a 0 to 10.

The E-Text Reader MAC remembers the most recent voice selection. Users need only
set the voice when a change is desired. Select the OK button to close the window and
save the changes. Select the Cancel button to close the window without saving any of the

changes.

Advanced Reading Options
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Each option below the primary voice selection is related to the Auditory Highlighting.
There must be a check in the “Enable Auditory Highlighting” checkbox to activate the
Advanced Reading options. If these features are not enabled the application will read
with only the primary voice.

Select a secondary voice. It is recommended that the secondary voice be a completely
different sounding voice. If your primary voice is female, then select a masculine voice
for the second voice. Voices with greater differences allow the information to be more
distinguishable. The secondary voice will be used whenever the application detects text
with a highlight.

Readers can scroll through the list of voices to find the desired voice. Once the desired
voice has been selected, the rate can be adjusted by moving the Voice Rate slide bar to
the right for faster and left for slower. Select the Test button to hear what the new settings
sound like. The Rate can be adjusted from a 0 to 10.

Select the OK button to close the window and save the changes. Select the Cancel button
to close the window without saving any of the changes.
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Extracting Highlights

The E-Text Reader MAC has a built-in highlighting feature that allows the user to
highlight any information in one of four different colors: yellow, blue, pink and green.
These highlight colors are unique and do not interfere with any other color within the
document. This makes it possible for the E-Text Reader MAC to distinguish between the
highlighted text and text that has a similar color background. The E-Text Reader MAC
allows the extract of all the highlight colors or just one.

The extracted information is placed in a separate document that the user can then save or
have read aloud. This document can be saved as Text and Rich Text Format (.rtf).

How to Extract Text

The E-Text Reader MAC can also reads information that has been copied and pasted into
the application. Once the document has been opened, the desired information can be
highlighted. When the highlighting is completed, click the Extract button. The E-Text
Reader MAC processes the document and locates all the highlights that have been added.

Once all the highlights have been located, the user is presented with an Extract Colors
window

Extraction
Extract Colors Extract Options
Order/Level () Group By Calor
M vellow (1 [+] () Indent By Color
™ Blue m o Extract As
7 Green [3 12 ~ Highlighted

™ Pink 4 e

Extract

From the Extract Colors window, the user can select the colors to be extracted as well as
the method of extraction.
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Group by Color

Highlighted extractions can be grouped by color. User must identify the order in which
colors are to be extracted. Changing the Order/Level option indicates the order in which
the extraction occurs.

Indent by Level

User can also create an indented outline. To set the level of indenting of a highlighted
color, select the Order/Level option. Colors set to level one have no indentation. Colors
set to level two have one tab indent. Colors set to level three have two tab indents.
Colors set to level four have three tab indents. Users can also have multiple colors with
the same indent levels.

Extract as Highlighted

This option extracts the highlights in the order in which they were selected within the
document.
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Help

This entire manual is also compiled into the Help file so that users can quickly search for

a topic. To activate the Help file, just click on the Help button or Press F1.

About

The version number of the E-Text Reader MAC is found under the Help menu. Select
the About option.

\et

E-Text Reader Mac 2.0

E-Text Reader Mac is a product of
Premier Assistive Technology, Inc.
Joliet, IL USA
www.readingmadeez.com

Copyright 2002-2010. All Rights Reserved.
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Appendix A — System Requirements

Operating System: Mac OS X 10.6.6 or later

Memory: 512 MB of RAM

CPU: 500 MHz or Faster

CD ROM Drive: 4X or Faster (only required if installing from CD)
Misc: Sound card with speakers (or headphones), keyboard, mouse
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